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Welcome to 2017 Knowledge-Based Audits™ of International Entities for ProSystem fx® Knowledge Coach

This Release Notes document provides important information about the 2017 release of Knowledge Based Audits ™ of International
Entities. Please review this information carefully. If you have any questions, contact Customer Support at 1-800-PFX-9998. Additional
information is available on CCH Support Online.

New in this Release

Knowledge-Based Audits of International Entities is designed to help the auditor efficiently and effectively perform financial statement
audits of international commercial entities in accordance with International Standards on Auditing (ISAs) promulgated by the
International Auditing and Assurance Standards Board (IAASB). The knowledge-based audit is a risk-based methodology that
emphasizes using knowledge of the entity to make risk assessments in connection with a financial statement audit. This allows the
auditor to more appropriately focus audit efforts on those areas which in the auditor’s judgement are the most significant and pose the
most risk of material misstatement to the financial statements.

The KBA methodology drives audit strategy that is scalable to any size engagement, in any industry, whilst aiding the auditor in
achieving efficiencies and effectiveness resulting in overall cost-savings by helping to reduce the tendency to over audit. These
workpapers include practice aids, audit programs, checklists, questionnaires, workpapers, sample correspondence, and sample auditor's
reports that take the practitioner through an engagement from the initial evaluation of an entity to the issuance of the auditor's reports
on the financial statements. These workpapers also include interpretive guidance, workpapers, review programs, checklists, and
correspondence necessary to complete reviews of interim financial information in accordance with International Standard on Review
Engagements (ISRE) 2410, AU-C Section 930, Review of Interim Financial Information Performed by the Independent Auditor of the
Entity, should this be required as part of the engagement.

The operations of international entities are often unique and complex and require specialized accounting and auditing knowledge.
Conducting audits of international entities requires the exercise of the auditor’s professional judgement. This document is published for
the purpose of communicating, to users of the toolset, updates and enhancements included in the current version. This document is
not, and should not be used as an audit program to update the audit documentation of an engagement started in a previous version of
this product.

This is the fourth update to this Knowledge Coach title. If you are updating from a previous version of this title, refer to the Knowledge
Coach User Guide Chapter 12. The guide is found on the Engagement File Room Help menu.

The 2017 documents include Accounting Research Material links to specific guidance that provides instant access to detailed analysis
related to the steps and processes discussed in the workpapers.

The 2017 edition of Knowledge-Based Audits of International Entities features numerous enhancements, including:

¢ AUD-903 and AUD-904 have been streamlined and minimized for duplication elsewhere. Some steps in AUD-903 have been
moved to KBA-501.

¢ AUD-802 Audit Program: Investments in Securities, Derivative Instruments, and Hedging Activities has been split into AUD-
802A Audit Program: Investments in Securities and AUD-802B Audit Program: Derivative Instruments and Hedging Activities.

¢ The Investment in Securities, Derivative Instruments, and Hedging Activities audit area from the 2016 International Entities Title
is now split into two separate audit areas: 1) Investments in Securities and 2) Derivative Instruments and Hedging Activities.

¢ Anew section has been added to AID-201 to address "Threats and Safeguards" regarding auditor independence.

¢ Anew table has been added to KBA-101 for users to document why the auditor isn't testing the operating effectiveness of
internal controls. If the auditor has selected in AUD-100 that the auditor intends to test the operating effectiveness of internal
controls over financial reporting will be tested, this table will be hidden.


http://support.cch.com/productsupport/

¢ KBA-105 has been reorganized so that the user will add entries to column 1 instead of column 3 so the flow is more logical.

¢ New columns have been added to AID-701 which will allow the user to select whether the assertion is relevant or not. For any
assertion marked as not relevant the user will NOT need to complete the planned level of control risk. The selections made in
this new column will flow to other areas of the workpaper.

¢ A comments column has been added to KBA-400 Scoping and Mapping Table and in KBA-502 Assertion Level Risk Table.
¢ Anoption for a Not Applicable answer has been added to question 9 of AUD-602.

¢ Anew Not Applicable option has been added in KBA-103 column 15, "If Not a Significant Deficiency, Is It Important Enough to
Merit Attention by Management?"

¢ Changes have been made to address issues with risk information not flowing correctly to KBA-40x series workpaper when cash
receipts/cash disbursements have been selected.

¢ Changes have been made to clarify various risk diagnostics so that the correct diagnostics are displayed at the proper time.

¢ New Resource Document as follows:
o RES-024 Special Considerations in Auditing Financial Instruments

Click here for the 2017 International Entities Title Overview for Knowledge Coach Users

In addition, forms and practice aids throughout have been updated to include new examples and tips and, where applicable, to take into
account:

New literature, standards, and developments, reflected in the following current audit and accounting guidance:

¢ ISRE 2410, AU-C Section 930, Review of Interim Financial Information Performed by the Independent Auditor of the Entity
¢ ISA 810 (Revised), Engagements to Report on Summary Financial Statements
Important Notes

¢ Make sure to save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

¢ If your Current Editor Knowledge Coach MS® Word workpapers become read-only or crash, please do the following:
o Keep the binder with the affected workpapers open.
o Highlight the workpaper in the binder window and go to Tools > Save Knowledge Coach Answers.
¢ Asof the December 2016 update to Engagement 7.5 and Knowledge Coach 2.5, you can open binders that contain Knowledge
Coach workpapers when logged into the Shared File Room (SFR) mode in Engagement with the following restrictions:
o Knowledge Coach workpapers cannot be edited in the SFR mode.

o However, Knowledge Coach workpapers can be viewed as read-only, signed off on, and workpaper notes can be
written on Knowledge Coach workpapers while in the SFR mode.

o Non-Knowledge Coach workpapers can be edited in SFR mode without restriction.
System Requirements
¢ This title MUST be used with ProSystem fx ® Engagement version 7.5 or higher, ProSystem fx® Knowledge Coach version 2.5,
and 2016 Financial Statement Base v3 or higher. If you have not installed the ProSystem fx® Engagement 7.5 and Knowledge

2.5, ensure that you do so before using this title. If you are upgrading from ProSystem fx® Engagement 7.1 or lower please
contact Technical Support at 1-800-PFX-9998 for detailed instructions.

¢ Aminimum of 4GB of RAM is required for optimal performance when opening and navigating through ProSystem fx®
Knowledge Coach workpapers.

Download Instructions

Download the 2017 Knowledge Based Audits of International Entities from the ProSystem fx ®Knowledge Coach Updates section of the
ProSystem fx® Engagement Support Web site at the following URL: http://support.cch.com/updates/KnowledgeCoach, then select the
Knowledge Coach Series and Download file link next to the 2017 Knowledge-Based Audits of International Entities. On some occasions
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the content package file (.KCP) will download with the extension changed to .ZIP. If this occurs, please change the extension of the
downloaded file to KCP using all capital letters.

You must install the 2016 Financial Statement Base v3 title before installing the 2017 Knowledge Based Audits of International Entities.
The Financial Statement Base title is also available at the following link: http://support.cch.com/updates/KnowledgeCoach

Important: ProSystem fx® Engagement version 7.5 or higher and Knowledge Coach version 2.5 must be installed on the computer in
order to install this Knowledge Coach title. Additional requirements include Microsoft® Office 2010, Microsoft® Office 2010 Primary
Interop Assemblies (PIA) and Visual Studio® 2005 Tools for the Office Second Edition Runtime, Visual Studio® Tools for Office System
Runtime version 3.0, and Visual Studio® Tools for the Office System 3.0 Runtime Service Pack 1., Visual Studio® Tools for Office
Runtime 4.0 (VSTOR) (32-bit version for 32-bit OS and 64-bit version for 64-bit OS).

The 2017 Knowledge-Based Audits of International Entities (12/29/16).KCP download is a proprietary file that must be installed from
within Engagement. Save this KCP file to a location on your local drive and follow the Installation Instructions included in the Release
Bulletin.

Installation Instructions

Once you have downloaded your Knowledge Coach title, you will need to add it to the list of titles within ProSystem fx ® Engagement.
The only additional system requirement is approximately 75MB of disk space to store your Knowledge Coach Program content files.
Please refer to the ProSystem fx ® Engagement with Knowledge Coach Release Notes for any other system requirements.

After downloading the 2017 Knowledge Based Audits of International Entities, do the following:

¢ Launch the ProSystem fx ® Engagement Workpaper Management application so that the Local File Room is displayed. Select
Tools > Knowledge Coach Titles.

¢ The Knowledge Coach Titles window will be displayed.
¢ Choose Add Title.

¢ Browse to the title package file (*.KCP) that you previously downloaded from the ProSystem fx ® Knowledge Coach Support
Web site.

¢ Choose Open.

¢ The system will display a progress indicator while the title package is added. You will receive a message that the title has been
successfully installed once the process is complete.

Note: You can determine this access in the ProSystem fx® Engagement Admin module by selecting a staff group and choosing File >
Properties > Content “Insert Knowledge Coach workpapers from unreleased titles” option.

To release a title:
¢ Select one of the Knowledge Coach titles in the list that has been added but is not yet released.

¢ Choose Release Title. The current date and time will be displayed in the Date released column, and the status will change to
“Released.”

Note: You must add and assign a Knowledge Coach module as well as the Knowledge Coach title license in the ProSystem fx ®
Engagement Administrator before using the workpapers.

Important: Once the 2017 Knowledge-Based Audits of the International Entities title has been added and released, they will be
automatically deployed to other staff members when they login to the “Office” location, or when they synchronize a binder that
contains Knowledge Coach workpapers from this title.

Online Permission Key

Permission key files may be downloaded from our Web site at https://prosystemfxsupport.tax.cchgroup.com/permkey/download.aspx
or when adding or updating the new licenses within ProSystem fx® Engagement with Knowledge Coach version 7.5 and higher. After
updating the license file in the ProSystem fx® Engagement Admin module, licenses need to be assigned to the staff who will use 2017
Knowledge-Based Audits of International Entities.
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If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Accounting Research Manager

CCH's Accounting Research Manager ("ARM") is the most comprehensive, up-to-date and objective online database of financial
reporting literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written

interpretive guidance.

Available on ARM, the Knowledge-Based Audits of International Entities Guide helps you comply with the most recent professional
standards and guidance for the conduct of audits of International entities and to integrate the use of practice aids, tools, and other
resources with its guidance. This publication supplements and complements the Knowledge-Based documents that are available in

Knowledge Coach.

If you subscribe to an ARM library that includes International Entities content, you can link directly to source material from Resources
within Knowledge Coach documents. These links have been updated to refer to the accounting standards under the IASB Accounting

Standards. Also, if you subscribe to the Knowledge-Based Audits of International Entities Guide on ARM, you can take advantage of

references to the guide material from within the Knowledge Coach documents.

With Accounting Research Manager, you maximize the efficiency of your research time, while enhancing your results. Learn more about
our content, our experts, and how you can request your free trial by visiting http://www.accountingresearchmanager.com. You can also
access the Accounting Research Manager Web site by selecting the item in ProSystem fx ® Engagement from the Guidance tab on the

Shortcuts bar in the Binder window.

Using Your Knowledge Coach Content

To use your Knowledge Coach Workpaper Templates, open a binder in ProSystem fx® Engagement, select the workpaper tab into which
you would like to insert the workpaper, and select New Knowledge Coach Workpaper from the toolbar or File menu. The New
Knowledge Coach Workpaper dialog appears (Figure 1).

Select the New Knowledge
Coach Title with the
content you would like to
use. You can only select
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The information displayed
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workpaper organization
available for the selected
title.
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Coach Workpaper
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your binder and click OK.
The Selected Workpaper
Properties dialog appears.
Each workpaper name is
automatically loaded into
the Name field. Add a
workpaper index in the
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workpaper. Then click OK.
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Figure 1 - New Knowledge Coach Workpaper
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The integrated Knowledge Coach workpaper is now inserted into your engagement binder. For more information on how to use
Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.

Additional Information on Knowledge Coach and the KBA Methodology

Knowledge-Based Audit (KBA) Methodology - Allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:

¢
¢

An Overview that guides auditors through the methodology;

Knowledge-Based Audit documents, integral to the risk assessment and overall audit processes, which contain steps and
procedures required by ISAs;

Customizable Audit Programs that take auditors through related steps and procedures;

Practice Aids to help auditors complete steps or processes outlined in the Knowledge-Based Audit documents and Audit
Programs;

Auditor’s Reports that provide a variety of sample auditor’s opinions on audited financial statements; and

Correspondence documents that provide sample letters to be used to comply with ISA requirements and in many other
common situations.

The International Auditing and Assurance Standards Board's (IAASB) Risk Assessment Standards - The practice aids and tools in
the 2017 Knowledge-Based Audits of International Entities are designed around the IAASB's risk assessment standards to assist
auditors of nonpublic international entities by:

e  Facilitating compliance with ISAs;
e Encouraging more effective audits through tailored audit programs and comprehensive practice aids;
e Helping auditors to focus on and respond to identified audit risks; and

e Enhancing audit documentation.

ProSystem fx® Knowledge Coach

¢

ProSystem fx® Knowledge Coach functionality allows auditors/accountants to use the Knowledge-Based-Audit methodology
more efficiently by eliminating the need for duplicate entry of the same information, tailoring audit documentation to each
particular engagement, and documenting the link between risks identified and procedures performed. AUD-100 Tailoring
Question Workpaper is a document in Knowledge Coach that presents engagement-level questions designed to aid in tailoring
the engagement documentation to fit each client. Completing the questions helps the auditor avoid duplication and
unnecessary workpapers.

Before you begin your audit, please review the guidance in AUD-101 Overall Audit Program. This workpaper is intended to be
your road map through a Knowledge-Based Audit methodology. You should start your audit with AUD-100 Tailoring Question
Workpaper and AUD-101 Overall Audit Program.

Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows the user to continuously assess risks during the engagement. Several workpapers
prompt the consideration of the presence of risks, but the Risk Summary task pane must be used to document those risks. All
documented risks flow to the Risk Summary. To ensure risks show in findings tables, make sure to check the “workpaper
identified in” field of the Risk pane.



¢ Information Flow helps cut down on the time spent duplicating information across forms. In addition, the flow of consistent
information ensures that information and updates to information are not missed between workpapers. Drill-down functionality
helps the user navigate quickly to the source of the information, aiding in the review of the audit file.

¢ Diagnostics help keep track of unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks
or relevant assertions, missing workpaper, and more.

¢ Links to Accounting Research Manager (ARM)-If you subscribe to an ARM library that includes audit content, you can link
directly to source material from Resources within Knowledge Coach workpapers. These links have been updated to reference to
the accounting standards under the International Auditing and Assurance Standards Board. Also, if you subscribe to the
Knowledge-Based Audits of International Entities Guide on ARM, you can take advantage of links to the audit guide material
from within the Knowledge Coach documents.

¢ Interpretive Guidance is integrated into each Knowledge Coach template through the Tips view of each new task pane.
Informational features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more
effectively and efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH'’s Accounting
Research Manager and industry audit guides by simply clicking on the Reference.

Download 2017 Knowledge-Based Audits of International

Description: Entities(12/29/2016)

Version: Engagement v. 7.5 with Knowledge Coach 2.5 or higher and
' 2016 Financial Statement Base v3

Release Date: December 2016

File size: 18MB

Approx. Download 42 minutes at 56 kbps

Time:

License: Full Version

Platforms: Windows® 7, 8, 8.1, 10

Office: Microsoft® Office 2010 or higher required

Contact Information

¢ For ademo or to purchase additional titles as they become available ~1-800-PFX-9998

¢ Technical Support 1-800-PFX-9998



The ProSystem fx® Engagement version of the Knowledge Coach Integrated Knowledge-Based Guides is sold and supported by CCH, a
Wolters Kluwer business. The contact information above can be used for customer service and support issues for this product. For
information about other CCH products, please call 1-800-248-3248 or visit the online Store at http://tax.cchgroup.com.



